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This document discusses the Cisco Network Management Support CD
release and includes the following information:

• What’s New in this Release, page 1

• README Files for Device Support, page 5

In addition to this release note, use theCiscoView Release Note or the
CiscoWorks Windows Release Note when installing and using CiscoView.

Note This README file was updated on 5/30/97. It is included on the CD
and appears on CCO for your convenience. There is no orderable document
available. For more recent release information, check Cisco Connection
Online (CCO) for possible updates.

What’s New in this Release
The Cisco Network Management Support CD now includes several new and
updated Cisco devices that work with the CiscoView application. These
devices are also available from the Cisco Connection Online (CCO) service.
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What’s New in this Release

To mount and install devices from the support CD, refer to the special CD
booklet included in your package. Be sure to read the README files on the
Network Management Support CD or turn to the section “README Files for
Device Support.”

Caution Before installing CiscoView or CiscoView devices, read the
caveats in your CiscoView or CiscoWorks Windows release note section
“Installation Notes and Caveats.”

CiscoView consists of the CiscoView 3.1.1 product (also referred to as the
CiscoView engine) and device support, plus the additional device support
now found on the Network Management Support CD. If you already have
release 3.1 installed, you do not need to reinstall release 3.2 (1). Only install
the devices you need off the Network Management Support CD.
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What’s New in this Release

Table 1 lists the new or updated Cisco devices included on the Network
Management Support CD. These devices are supported on all platforms
unless otherwise noted.

Table 1 New Device Support in CiscoView Release 3.2

Supported Operating Systems and
Network Management Software

Cisco Device
Software
Releases

SunOS/
Solaris
and SNM1

SunOS/
Solaris
and HP
OpenView 2

HP-UX
and HP
OpenView 3

NetView
AIX4

Windows
95 or
NT3.5.1

765 and 766
Cisco IOS 10.3,
11.0, and 11.1 X X X X X

CiscoPro 765 and
766

Cisco IOS 10.3,
11.0, and 11.1 X X X X X

1003, 1004, and
1005

Cisco IOS 10.3,
11.0, and 11.1 X X X X X

2520, 2521,
2522, 2523,
2524, 2525,
4000, 4000-M,
4500, 4500-M,
4700, 4700-M

Cisco IOS
Software Release
10.0 to 11.1
(Releases 10.2
and 10.3 do not
support all cards
for the 4000
Series routers.) X X X X X

CiscoPro 4500
Cisco IOS 11.1
through 11.3 X X X X X

CiscoPro 2520,
2522, 2524

Cisco IOS 10.3,
11.0, and 11.1 X X X X X

AS5200
Universal Access
Server

Cisco IOS
11.1(5)

SunOS 4.1.x
(Solaris 1.x) NA

HP-UX 9.0.4
HP
OpenView
3.3 NA

HP-UX 9.0.4
HP
OpenView
3.3

7206 Cisco IOS
11.1(5) X X X X X
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Catalyst 1200
Cisco Software
Release 4.1 X X X X X

Catalyst 1600
Cisco Software
Release 11.1 X X X X X

Catalyst 1800

Cisco Software
Release
TRX/FDU.2.1.10 X X X X X

Catalyst 2600
Cisco Software
Release SR-2.06 X X X X X

Catalyst 2900
Cisco Software
Release 2.1 X X X X X

Catalyst 3000

Cisco Software
Release 1.1, 1.2,
and 1.3 X X X X X

Catalyst 5000

Cisco Software
Release 1.4, 1.5,
and 2.1 X X X X X

CPW16
Cisco Software
Release 1.1 X X X X X

CPW1220,
CPW1420,
Cat1900, and
Cat2820

Cisco Software
Release 1.0 X X X X X

CPW 2200 Software Release
2.1 X X X X X

Grand Junction
FastSwitch 2100
and 2800

Sofware Release
3.62

X X X X X

EtherSwitch
10/100 and
Catalyst 1700

 Software Release
1.38

X X X X X

Supported Operating Systems and
Network Management Software

Cisco Device
Software
Releases

SunOS/
Solaris
and SNM1

SunOS/
Solaris
and HP
OpenView 2

HP-UX
and HP
OpenView 3

NetView
AIX4

Windows
95 or
NT3.5.1
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README Files for Device Support
The following README files describe device support included on this
release:

• Cisco 760 and CP760 Series Device (760.cv311.P2-0.readme)

• Cisco 1000 Series Device (1000.cv311.P2-0.readme)

• Cisco 1600 Device (1600.cv311.P1-0.readme)

• Cisco 2500 Series Device (2500.cv311.P3-0.readme)

• Cisco 3600 Device (3600.cv311.P1-0.readme)

• Cisco 4000, 4500, 4700, and 2500 Series Devices
(4000.cv311.P4-1.readme)

1. Includes SunOS 4.1.3, 4.1.4, Solaris 2.4 with SunNet Manager 2.2.2 and Solaris 2.5 and 2.51 with SNM 2.2.3 or 2.3
2. Includes SunOS 4.1.3, 4.1.4, Solaris 2.4 with HP OpenView 3.3 and Solaris 2.5 and 2.51 with HP OpenView 4.01 and 4.1. Solaris 2.5

and HP OpenView 4.1 require a patch. For more information, refer to “Installation Notes and Caveats” in the CiscoView or
CiscoWorks Windows Release Notes.

3. Includes HP-UX 9.04, 9.05 with HP OpenView 3.3 and HP-UX 10.0 and 10.10 with HP OpenView 4.01 and 4.1
4. Includes NetView for AIX 4.1 or 3.1 (optional) and AIX version 3.2.5(1) or 4.1

Grand Junction
FastSwitch
10/100

Software Release
1.37

X X X X X

Catalyst 2100
and 2800,
EtherSwitch
1200 and 1400

Software Release
3.63

X X X X X

Fasthub 100+ and
Netbeyond
Fasthub 300

Software Release
1.12

X X X X X

LS1010
Software Release
11.1, IISP X X X X X

Supported Operating Systems and
Network Management Software

Cisco Device
Software
Releases

SunOS/
Solaris
and SNM1

SunOS/
Solaris
and HP
OpenView 2

HP-UX
and HP
OpenView 3

NetView
AIX4

Windows
95 or
NT3.5.1
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• Cisco 7000 Series Device (7000.cv311.P3-0.readme)

• Cisco AS5200 Device (AS5200.cv311.P2-0.readme)

• Cisco Catalyst 1200 Device (cat1200.cv311.P1-1.readme)

• Cisco Catalyst 1600 Device (cat1600.cv311.P1-1.readme) -- FILE
MISSING from CCO?

• Cisco Catalyst 1800 Device (cat1800.cv311.P1-1.readme)

• Cisco CPW16 Device (cpw16.cv311.P1-1.readme)

• Cisco CPW1220, CPW1420, Cat1900, and Cat2820 Devices
(cat1900.cv311.P1-0.readme)

• Cisco CPW2200 Device (cpw2200.cv311.P1-2.readme)

• Cisco Catalyst 2600 Device (cat2600.cv311.P1-1.readme)

• Cisco Catalyst 2900 Device (cat2900.cv311.P1-2.readme)

• Cisco Catalyst 3000 Series Device (cat3000.cv311.P2-0.readme)

• Cisco Catalyst 5000 Device (cat5000.cv311.P1-2.readme)

• Cisco CPW10-100, CPW1200, CPW1400, Catalyst 1700, Catalyst 2100,
and Catalyst 2800 (cpw1-_100.cv311.P1-1.readme)

• Cisco CPW2200 Device (cpw2200.cv311.P1-2.readme)

• Cisco Catalyst WG-Concentrator Device
(wg-concentrator.cv311.P1-2.readme

• Cisco Fasthub 100+ Series (FHUB_100_PLUS.cv311.P1-0.readme)

• Cisco Netbeyond Fasthub 300 Series
(NETBEYOND_FHUB_300.cv311.P1-1.readme)

• Cisco LS1010 Device (ls1010.cv311.P1-0.readme)

• Threshold Manager Application (TM.cv311.P1-1.readme)

Cisco 760 and CP760 Series Device
This ReadMe file includes the following sections:

* Introduction

* Devices supported
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* Tar file (*.tar)

* MIB files

* CiscoView and CiscoWorks Windows releases

* Network management platforms

* Operating systems

* Cisco IOS-700 software releases

* Current documentation

* Caveats

INTRODUCTION
*************************************************************
**

The 760 series and CPA760 series routers provide professional offices,

small offices, and individuals with affordable, high-speed remote access to

networks and the Internet in a modem-sized package. The routers connect

Ethernet LANs to corporate networks over Integrated Services Digital

Network (ISDN) Basic Rate Interface (BRI) lines. They offer multiprotocol

routing between WAN and LAN ports, as well as transparent bridging.

DEVICES SUPPORTED
**********************************************************

This incremental install includes support for the following routers:

* Cisco 761 and CPA761

* Cisco 762 and CPA762

* Cisco 765 and CPA765

* Cisco 766 and CPA766

TAR FILE
*************************************************************
******

The tar file (*.tar) includes the electronic network management device
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package file (*.pkg) that enables you to view and manage the Cisco 760

series routers using CiscoView and CiscoWorks Windows. The tar file also

includes a copy of this ReadMe file.

MIB FILES
*************************************************************
*****

Simple Network Management Protocol (SNMP) Management Information
Base (MIB)

files are available for network management. The following Cisco Connection

Online (CCO) Web location contains many MIBs:

ftp://ftp-eng.cisco.com/pub/mibs/supportlists/as5200/supportlist.html

CISCOVIEW AND CISCOWORKS WINDOWS RELEASES
**********************************

The supporting CiscoView release is CiscoView 3.1(1).

The supporting CiscoWorks Windows release is CiscoWorks Windows
2.0(1).

NETWORK MANAGEMENT PLATFORMS
***********************************************

The network management platforms supported are the same platforms that
are

available for CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):
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* UNIX: Sun workstation: SunNet Manager 2.2.2

* UNIX: Sun workstation: Hewlett-Packard (HP) OpenView 3.3

* UNIX: HP system: HP OpenView (HPOV) for UNIX 3.3

* UNIX: HP OpenView (HPOV) with Solaris

* UNIX: SunNet Manager (SNM) with Solaris

* UNIX: Standalone HP-UX and Sun UNIX

* PC: HP OpenView for Windows 95 and Windows NT, Release 7.2b
(C.02.17)

* PC: CastleRock SNMPc 4.1g with HP OpenView emulation support with

    Windows 95 and Windows NT

* PC: Standalone Windows 95 and Windows NT

OPERATING SYSTEMS
**********************************************************

The Cisco 760 series and CPA760 series router file (*.pkg)

runs on the same operating systems as CiscoView 3.1(1) and CiscoWorks

Windows 2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),
or

 Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95 4.0

* Windows NT 3.51
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CISCO IOS-700 SOFTWARE RELEASES
********************************************

Cisco IOS-700 Software Releases 3.2(2) and 3.2(4) support the Cisco 760

series and CPA760 series routers.

CURRENT DOCUMENTATION
******************************************************

Look for these documents on the Cisco Connection Documentation
CD-ROMs:

Cisco 760 series and CPA760 series documentation:

* The router installation and configuration guide

* The router command reference

* Cisco ConnectPro User Guide

CiscoView and CiscoWorks Windows documentation:

* CiscoView 3.1.(1) Release Notes

* CiscoWorks Windows 2.0(1) Release Notes

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)
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CAVEATS
*************************************************************
*******

1. The Cisco 760 series and CPA760 series routers do not support the SNMP

set operations.

2. No management support is available for the Config port (configure port)

option.

Cisco 1000 Series Device
This ReadMe file includes the following sections:

* Introduction

* What's New

* Tar File (*.tar)

* CiscoView and CiscoWorks Windows Releases

* Network Management Platforms

* Operating Systems

* Cisco Internetwork Operating System (Cisco IOS) Software Releases

* Current Documentation

* Caveats

*************************************************************
**

INTRODUCTION

Cisco 1000 series routers are easy-to-install, inexpensive,
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multiprotocol routers designed for small offices and other remote sites.

Cisco 1000 series routers include the following models:

Cisco 1003, CPA1003, Cisco 1004, CPA1004, Cisco 1005 and CPA1005.

*************************************************************
**

WHAT'S NEW

This release includes support for additional network management

platforms and operating systems, and support for the

Cisco CPA1003, CPA1004 and CPA1005.

*************************************************************
******

TAR FILE

The tar file (*.tar) includes the electronic network management device

package file (*.pkg) that enables you to view and manage Cisco 1000

series routers using CiscoView and CiscoWorks Windows. The tar file

includes a copy of this ReadMe file.

*************************************************************
*******

CISCOVIEW AND CISCOWORKS WINDOWS RELEASES

The supporting CiscoView release is CiscoView 3.1(1).

The supporting CiscoWorks Windows release is CiscoWorks Windows
2.0(1).
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*************************************************************
*******

NETWORK MANAGEMENT PLATFORMS

The network management platforms supported are the same platforms

as are available for CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* UNIX: Sun workstation: SunNet Manager 2.2.2

* UNIX: Sun workstation: Hewlett-Packard (HP) OpenView (OV) 3.3

* UNIX: HP system: HP OpenView (HPOV) for UNIX 3.3

* UNIX: HP OpenView (HPOV) with Solaris

* UNIX: SunNet Manager (SNM) with Solaris

* UNIX: Standalone HP-UX and Sun UNIX

* AIX: NetView for AIX 3.1 or 4.1

* PC: HP OpenView (HPOV) for Windows 95 and Windows NT,

      Release 7.2b (C.02.17)

* PC: CastleRock SNMPc 4.1g with HP OpenView (HPOV) emulation

       support with Windows 95 and Windows NT

* PC: Standalone Windows 95 and Windows NT

*************************************************************
*******

OPERATING SYSTEMS

The Cisco 1000 series device package file (*.pkg) runs on the same

operating systems as CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):
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* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

   or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 or 4.1

* Windows 95 4.0

* Windows NT 3.51

*************************************************************
*******

CISCO INTERNETWORK OPERATING SYSTEM (CISCO IOS)
SOFTWARE RELEASES

Cisco IOS software Releases 10.3, 11.0 and 11.1 support Cisco 1000

series routers.

*************************************************************
*******

CURRENT DOCUMENTATION

Look for these documents on the Documentation CD-ROM:

Cisco 1000 series documentation:

* Cisco 1003 and Cisco 1004 User Guide

* Cisco 1005 User Guide

* Cisco 1003 and Cisco 1004 Public Network Certification

* Cisco 1005 Public Network Certification

* Upgrading the DRAM SIMM in the Cisco 1003, 1004, and 1005
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CiscoView and CiscoWorks Windows documentation:

* CiscoView 3.1.(1) Release Note

* CiscoView Incremental Installation Quick Reference

* CiscoView CD Installation Instructions

* CiscoWorks Windows 2.0(1) Release Note

* CiscoWorks Windows Incremental Installation Quick Reference

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

*************************************************************
*******

CAVEATS

None at this time.

Cisco 1600 Device
This ReadMe file includes the following sections:

* Introduction

* Tar file (*.tar)

* MIB files

* CiscoView and CiscoWorks Windows releases

* Network management platforms

* Operating systems

* Cisco Internet Operating System (Cisco IOS) software release
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* Current documentation

* Caveats

INTRODUCTION
*************************************************************
**

The Cisco 1600 series includes the Cisco 1601, CPA1601, Cisco 1602,

CPA1602, Cisco 1603, CPA1603, Cisco 1604, and CPA1604. The Cisco 1600

series is a family of small desktop routers that link remote-site Ethernet

LANs to regional and central offices over multiple WAN connections.

TAR FILE
*************************************************************
*****

The tar file (*.tar) includes the electronic network management device

package file (*.pkg) that enables you to view and manage the Cisco 1600

using CiscoView and CiscoWorks Windows. The tar file also includes a copy

of this ReadMe file.

MIB FILES
*************************************************************
*****

SNMP MIB files are available for network management. The following Cisco

Customer Connection Online (CCO) WEB location contains many MIBs:

ftp://ftp-eng.cisco.com/pub/mibs/supportlists/as5200/supportlist.html
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CISCOVIEW AND CISCOWORKS WINDOWS RELEASES
**********************************

The supporting CiscoView release is CiscoView 3.1(1).

The supporting CiscoWorks Windows release is CiscoWorks Windows
2.0(1).

NETWORK MANAGEMENT PLATFORMS
************************************************

The following are the supported operating system and network management

platform combinations:

* UNIX: Sun workstation: SunNet Manager 2.2.2

* UNIX: Sun workstation: Hewlett-Packard (HP) OpenView 3.3

* UNIX: HP system: HPOV (HP OpenView) for UNIX 3.3

* UNIX: HPOV with Solaris

* UNIX: SNM (SunNet Manager) with Solaris

* UNIX: Stand-alone HPUX and SUN UNIX

* AIX: NetView for AIX 3.1 or 4.1

* PC: HP OpenView for Windows 95 and Windows NT, 7.2b (C.02.17)

* PC: CastleRock SNMPc 4.1g with HP OpenView emulation support with

    Windows 95 and Windows NT

* PC: Stand-alone Windows 95 and Windows NT
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OPERATING SYSTEMS
***********************************************************

The Cisco 1600 device package file (*.pkg) currently runs on the same

operating systems as CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),
or

 Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 or 4.1

* Windows 95 4.0

* Windows NT 3.51

CISCO IOS SOFTWARE RELEASE
*************************************************

Cisco IOS software release 11.1 supports the Cisco 1600 series routers.

CURRENT DOCUMENTATION
******************************************************

Look for some of these documents on the Cisco Connection Documentation,

Enterprise Series CD-ROM.  The quick reference cards are not on the
CD-ROM.

Cisco 1600 documentation:

The following two documents ship with every model:
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* Cisco 1600 Series Router Installation and Configuration Guide

* Regulatory Compliance and Safety Information for Cisco 1600 Series
Routers

The following configuration notes ship with spares for the Cisco 1600

series routers:

* Installing an ISDN BRI S/T WAN Interface Card in Cisco 1600 Series
Routers

* Installing an ISDN BRI U WAN Interface Card in Cisco 1600 Series
Routers

* Replacing the DRAM SIMM in Cisco 1600 Series Routers

The following quick reference cards are listed by hardware model:

* Cisco 1601

-Start Here

-Connecting Your Cisco 1601

-ClickStart for Cisco 1600 Series Routers

-Required Information for Frame Relay

-Configuring Frame Relay

-Required Information for a Leased Line

-Configuring a Leased Line

* Cisco 1602

-Start Here

-Connecting Your Cisco 1602
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-ClickStart for Cisco 1600 Series Routers

-Required Information for Frame Relay

-Configuring Frame Relay

-Required Information for a Leased Line

-Configuring a Leased Line

* Cisco 1603

-Start Here

-Connecting Your Cisco 1603

-ClickStart for Cisco 1600 Series Routers

-Required Information for ISDN

-Configuring ISDN

* Cisco 1604

-Start Here

-Connecting Your Cisco 1604

-ClickStart for Cisco 1600 Series Routers

-Required Information for ISDN

-Configuring ISDN

CiscoView documentation:

* CiscoView 3.1.(1) Release Note

* CiscoView Incremental Installation Quick Reference

* CiscoView CD Installation Instructions
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CAVEATS****************************************************
****************

This section contains caveats about problems related to the Cisco 1600 that

might while using CiscoView.

#1.

ID #: CSCdi73863 -

All Cisco 1600 WAN interface cards return an 'Unknown card type 36x'

message in the Card Configuration dialog box. This is caused by a bug in

snmptcl. You can ignore this message.

#2.

The new categories for the ISDN-U port type also show up for other port

types when rewinding and forwarding the port configuration dialog from the

ISDN-U port. You can ignore this problem.

#3.

For a few help topics, the help text might display topic names with 2500,

4000, 7000, or 7500. This is because some of the help topics used in the

Cisco 1600 help file are shared with other help files. To return to the

Cisco 1600 help file, from the CiscoView Main window, select Help, then

Contents. Select the Cisco 1600.

Cisco 2500 Series Device
This ReadMe file includes the following sections:
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* Introduction

* Tar file (*.tar)

* MIB files

* Devices supported

* Network processor modules supported

* Network management platforms

* Operating systems

* Cisco Internet Operating System (Cisco IOS) software releases

* Current documentation

* Caveats

INTRODUCTION
*************************************************************
***

Cisco 4000, Cisco 4500, and Cisco 4700 series routers (including the Cisco

4000-M, Cisco 4500-M, and Cisco 4700-M) provide a variety of features that

can accommodate all types of network computing environments.

Cisco 2500 series routers are available in a variety of models for small

offices and remote site environments.

TAR FILE
*************************************************************
*******

The tar file (*.tar) includes the electronic network management device

package file (*.pkg) that enables you to view and manage Cisco 4000, Cisco
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4500, Cisco 4700, and Cisco 2500 series routers using CiscoView and

CiscoWorks Windows. The tar file also includes a copy of this ReadMe file.

MIB FILES
*************************************************************
******

SNMP MIB files are available for network management. The following Cisco

Connection Online (CCO) URL contains many MIBs:

ftp://ftp-eng.cisco.com/pub/mibs/supportlists/as5200/supportlist.html

DEVICES SUPPORTED
***********************************************************

This incremental installation includes support for the following devices:

* Cisco 4000-M

* Cisco 4500-M

* Cisco 4700

* Cisco 4700-M

* CPA4700

* Cisco 2520

* Cisco 2521

* Cisco 2522

* Cisco 2523

* Cisco 2524
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* Cisco 2525

* CPA2501

* CPA2502

* CPA2503

* CPA2504

* CPA2505

* CPA2507

* CPA2509

* CPA2511

* CPA2513

* CPA2514

* CPA2516

* CPA2520

* CPA2521

* CPA2522

* CPA2523

* CPA2524

The basic version of CiscoView 3.1(1) and CiscoWorks Windows 2.0(1)

(without this incremental installation) includes support for the Cisco 4000

and Cisco 4500, and Cisco 2501 through Cisco 2516, except for the Cisco

2506 and Cisco 2508, which are not available.

NETWORK PROCESSOR MODULES SUPPORTED
******************************************

This incremental installation includes support for the following network
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processor modules (npm):

* npm-4000-fddi-sas

* npm-4000-fddi-das

* npm-4000-1e

* npm-4000-1r

* npm-4000-2s

* npm-4000-2e1

* npm-4000-2e

* npm-4000-2r1

* npm-4000-2r

* npm-4000-4t

* npm-4000-4b

* npm-4000-8b

* npm-4000-ct1

* npm-4000-ce1

* npm-4000-1a

* npm-4000-6e

* npm-4000-1fe

NETWORK MANAGEMENT PLATFORMS
************************************************

The network management platforms supported are the same platforms that
are

available for CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* Sun workstation: SunNet Manager 2.2.2
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* Sun workstation: Hewlett-Packard (HP) OpenView 3.3

* HP system: HP OpenView for UNIX 3.3

* PC: HP OpenView for Windows, 7.2b (C.02.17)

* PC: CastleRock SNMPc 4.1g with HP OpenView emulation support

See CAVEATS at the end of this ReadMe for important information regarding

HP OpenView for Windows.

OPERATING SYSTEMS
************************************************************

The Cisco 4000, Cisco 4500, Cisco 4700, and Cisco 2500 series device

package (*.pkg) currently runs on the same operating systems as CiscoView

3.1(1) and CiscoWorks Windows 2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),
or

 Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95 4.0

* Windows NT 3.51

CISCO IOS SOFTWARE RELEASES
*************************************************

Cisco IOS Software Release 11.1 and earlier releases support Cisco 4000,

Cisco 4500, Cisco 4700, and Cisco 2500 series routers.

Note: Cisco IOS Releases 10.2 and 10.3 do not support all cards for the
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Cisco 4000 series routers. All Cisco 4000 series routers are supported in

Cisco IOS Release 11.0 and later releases.

CURRENT DOCUMENTATION
*******************************************************

Look for these documents on the Cisco Connection Documentation,
Enterprise

Series CD-ROM:

Cisco 4000 series documentation:

Cisco 4000 Series Installation Guide

 (use for Cisco 4000-M, Cisco 4500-M, Cisco 4700-M)

Cisco 4000 Series Hardware Installation and Maintenance

 (use for Cisco 4700)

Cisco 4000 Hardware Installation and Maintenance

 (use for Cisco 4000 and Cisco 4500)

Cisco 4000 series configuration notes:

Upgrading Memory in the Cisco 4000 and Cisco 4000-M

Upgrading the Cisco 4000 Flash EPROM Card (Cisco 4000)

Installing Network Processor Modules in the Cisco 4000 Series

Cisco 4000 Series Rack-Mount and Wall-Mount Installation

Upgrading System Software in the Cisco 4000 Series

Connecting the Cisco 4000 DC-Input Power Supply
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Upgrading Cisco 4500, Cisco 4500-M, Cisco 4700, and Cisco 4700-M
Memory

Upgrading the Flash EPROM Memory Card (Cisco 4000)

Cisco 2500 series documentation:

Cisco 2500 Series Router Installation Guide

 (Cisco 2501-2504 and Cisco 2513-2515)

Cisco 2500 Series Hardware Installation and Maintenance

 (Cisco 2505, Cisco 2507, Cisco 2516)

Cisco 2500 Series Hardware Installation

 (Cisco 2505, Cisco 2507, Cisco 2516)

Cisco 2500 Series Access Server User Guide

 (Cisco 2509, Cisco 2510, Cisco 2511, Cisco 2512)

Cisco 2517 and Cisco 2519 Router/Hub User Guide

Cisco 2518 Router/Hub User Guide

Cisco 2500 Series Multiport Serial Router User Guide

 (Cisco 2520, Cisco 2521, Cisco 2522, Cisco 2523)

Cisco 2524 and Cisco 2525 Router User Guide

Cisco 2500 series configuration notes:

- Upgrading the DRAM SIMM on the Cisco 2500 Series Routers

- Replacing the Boot ROMs in the Cisco 2500 Series and AccessPro PC Card

- Installing Dual Flash Memory SIMMs on the Cisco 2500 Series

- Upgrading Boot Image with Flash Memory Cards for Cisco 2500 Series
Routers

- Upgrading Feature Sets with Flash Cards for Cisco 2500 Series Routers
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CiscoView and CiscoWorks Windows documentation:

* CiscoView 3.1.(1) Release Note

* CiscoView Incremental Installation Quick Reference

* CiscoView CD Installation Instructions

* CiscoWorks Windows 2.0(1) Release Note

* CiscoWorks Windows Incremental Installation Quick Reference

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

CAVEATS****************************************************
******************

Note: Caveats 1 through 4 apply only to Cisco 2500 series routers:

1. The Cisco 2520, Cisco 2521, Cisco 2522, and Cisco 2523 routers had a bug

in the agent implementation that affected CiscoView. This bug was fixed in

Cisco IOS Release 11.0(5) and 11.1(2.1). For CiscoView to work properly,

these routers must have a Cisco IOS Release 11.0(5.1) and 11.1(2.1) or

later.

2. Cisco 2524 and Cisco 2525 routers have an extra MIB for the two
CSU/DSU

WAN cards. This MIB is implemented only in Cisco IOS Release 11.0(5).
These

routers can be viewed properly only if they have Cisco IOS Release 11.0(5)

or later.
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3. Cisco 2524 and Cisco 2525 routers have two CSU/DSU WAN card slots.
Each

of the slots can contain any one of the following cards:

   * Two-wire switched 56K/64K

   * Four-wire switched 56K/64K

   * Fractional T1

   * 5-in-1 serial

   * Empty

Because of a bug in the MIB agent implementation, there is no way to

distinguish between the 5-in-1 card in a slot and an empty slot. In both

cases, CiscoView displays the 5-in-1 card gif. (The gif is the viewable

picture of the device and cards.)

4. Cisco 2524 and Cisco 2525 routers have a BRI card slot, which can

contain either a BRI card with an NT1 interface or a BRI card without an

NT1 interface. At present, there is no way to differentiate between these

two cards using the MIB. In both cases, CiscoView displays the BRI card

without the NT1 gif.

5. The following Cisco Access devices require the current version of HP

OpenView for Windows, version 7.2b (C.02.17):

  Device Name:                            Tar Filename:
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* CPA2520, CPA2522, CPA2524               2500.cv311.Px-x.tar

* CPA4500                                 4000.cv311.Px-x.tar

Previously we notified you of a problem with HP OpenView for Windows,
7.2b

(C.02.14), where CiscoView did not recognize the Access devices listed

above. HP fixed this problem. The fix for this problem requires that you

upgrade HP OpenView for Windows and run a conversion utility for any of
the

affected device packages you might have installed.

HP OpenView for Windows must be upgraded (first to C.02.15, then to

C.02.17) to work with the above devices. For details on upgrading HP

OpenView for Windows and running the required conversion utility, refer to

the CiscoWorks Release Note, version 2.1(1).

Cisco 3600 Device
This ReadMe file includes the following sections:

* Introduction

* Tar file (*.tar)

* MIB files

* CiscoView and CiscoWorks Windows releases

* Network management platforms

* Operating systems

* Cisco Internet Operating System (Cisco IOS) software release

* Current documentation
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* Caveats

INTRODUCTION
*************************************************************
**

The Cisco 3600 series includes the Cisco 3640, CPA3640, Cisco 3620, and

CPA3620. The Cisco 3640 and CPA3640 are four-slot Access routers aimed
at

high-powered branch offices and small to midsize regional offices. The

Cisco 3620 and CPA3620 are two slot routers for small branch offices.

The Cisco 3600 series have interchangeable modules and WAN interface
cards.

The modular design provides flexibility.

TAR FILE
*************************************************************
*****

The tar file (*.tar) includes the electronic network management device

package file (*.pkg) that enables you to view and manage the Cisco 3600

using CiscoView and CiscoWorks Windows. The tar file also includes a copy

of this ReadMe file.

MIB FILES
*************************************************************
*****

SNMP MIB files are available for network management. The following Cisco
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Customer Connection Online (CCO) WEB location contains many MIBs:

ftp://ftp-eng.cisco.com/pub/mibs/supportlists/as5200/supportlist.html

CISCOVIEW AND CISCOWORKS WINDOWS RELEASES
**********************************

The supporting CiscoView release is CiscoView 3.1(1).

The supporting CiscoWorks Windows release is CiscoWorks Windows
2.0(1).

NETWORK MANAGEMENT PLATFORMS
************************************************

The following are the supported operating system and network management

platform combinations:

* UNIX: Sun workstation: SunNet Manager 2.2.2

* UNIX: Sun workstation: Hewlett-Packard (HP) OpenView 3.3

* UNIX: HP system: HPOV (HP OpenView) for UNIX 3.3

* UNIX: HPOV with Solaris

* UNIX: SNM (SunNet Manager) with Solaris

* UNIX: Stand-alone HPUX and SUN UNIX

* AIX: NetView for AIX 3.1 or 4.1

* PC: HP OpenView for Windows 95 and Windows NT, 7.2b (C.02.17)

* PC: CastleRock SNMPc 4.1g with HP OpenView emulation support with

    Windows 95 and Windows NT

* PC: Stand-alone Windows 95 and Windows NT
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OPERATING SYSTEMS
***********************************************************

The Cisco 3600 device package file (*.pkg) currently runs on the same

operating systems as CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),
or

 Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 or 4.1

* Windows 95 4.0

* Windows NT 3.51

CISCO IOS SOFTWARE RELEASE
*************************************************

Cisco IOS software release 11.1 supports the Cisco 3600 series routers.

CURRENT DOCUMENTATION
******************************************************

Look for these documents on the Cisco Connection Documentation,
Enterprise

Series CD-ROM.

Cisco 3600 documentation:
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* Cisco 3620 Installation and Configuration Guide

* Cisco 3640 Installation and Configuration Guide

* Regulatory Compliance and Safety Information

Cisco 3600 configuration notes:

* 1-Port and 2-Port ISDN-PRI Network Module Configuration Note

* WAN Card Slot Network Module Configuration Note

* Cisco 3600 Series Rack-Mount and Wall-Mount Configuration Note

* Upgrading Cisco 3600 Series Memory Configuration Note

* Cisco 3600 Series Power Supply Configuration Note

* Installing and Configuring Flash Memory Cards in Cisco 3600 Series
Routers

* 1-Port Serial WAN Interface Card Configuration Note

* 1-Port ISDN-BRI WAN Interface Card Configuration Note

* 4-Port and 8-Port ISDN-BRI Network Module Configuration Note

* 4-Port and 8-Port Asynchronous/Synchronous Seial Network Module

CiscoView and CiscoWorks Windows documentation:

* CiscoView 3.1.(1) Release Notes

* CiscoWorks Windows 2.0(1) Release Notes

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)



36 Cisco Network Management Support CD README (January 1997)

README Files for Device Support

CAVEATS****************************************************
****************

This section contains caveats about problems related to the Cisco 3600 that

might while using CiscoView.

#1.

ID #: CSCdi69480 -

For the T1/E1 ports, the configuration popup window shows only the ds1

configuration information. Interface information for these ports is not

shown. This is due to a bug in the agent implementation.

#2.

ID #: CSCdi73863 -

Some of the configuration popup windows for the port modules and daughter

cards show an error message "Unknown Card Type: xxx," where xxx is an

integer. This is caused by a problem with the CiscoView engine

(specifically snmpTcl). The error message means that CiscoView could not

translate the integer value xxx for the cardType MIB variable (obtained

from the router) into the enumeration defined in the chassis MIB.

Cisco 4000, 4500, 4700, and 2500 Series Devices
11/25/96

ReadMe File:

Update to CiscoView 3.1(1) and CiscoWorks Windows 2.0(1)--
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Cisco 4000, Cisco 4500, Cisco 4700, and Cisco 2500 Series Incremental

Installation

This ReadMe file includes the following sections:

* Introduction

* Tar file (*.tar)

* MIB files

* Devices supported

* Network processor modules supported

* Network management platforms

* Operating systems

* Cisco Internet Operating System (Cisco IOS) software releases

* Current documentation

* Caveats

INTRODUCTION
*************************************************************
***

Cisco 4000, Cisco 4500, and Cisco 4700 series routers (including the Cisco

4000-M, Cisco 4500-M, and Cisco 4700-M) provide a variety of features that

can accommodate all types of network computing environments.

Cisco 2500 series routers are available in a variety of models for small

offices and remote site environments.
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TAR FILE
*************************************************************
*******

The tar file (*.tar) includes the electronic network management device

package file (*.pkg) that enables you to view and manage Cisco 4000, Cisco

4500, Cisco 4700, and Cisco 2500 series routers using CiscoView and

CiscoWorks Windows. The tar file also includes a copy of this ReadMe file.

MIB FILES
*************************************************************
******

SNMP MIB files are available for network management. The following Cisco

Connection Online (CCO) URL contains many MIBs:

ftp://ftp-eng.cisco.com/pub/mibs/supportlists/as5200/supportlist.html

DEVICES SUPPORTED
***********************************************************

This incremental installation includes support for the following devices:

* Cisco 4000-M

* Cisco 4500-M

* Cisco 4700

* Cisco 4700-M

* CPA4700
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* Cisco 2520

* Cisco 2521

* Cisco 2522

* Cisco 2523

* Cisco 2524

* Cisco 2525

* CPA2501

* CPA2502

* CPA2503

* CPA2504

* CPA2505

* CPA2507

* CPA2509

* CPA2511

* CPA2513

* CPA2514

* CPA2516

* CPA2520

* CPA2521

* CPA2522

* CPA2523

* CPA2524

The basic version of CiscoView 3.1(1) and CiscoWorks Windows 2.0(1)

(without this incremental installation) includes support for the Cisco 4000

and Cisco 4500, and Cisco 2501 through Cisco 2516, except for the Cisco

2506 and Cisco 2508, which are not available.
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NETWORK PROCESSOR MODULES SUPPORTED
******************************************

This incremental installation includes support for the following network

processor modules (npm):

* npm-4000-fddi-sas

* npm-4000-fddi-das

* npm-4000-1e

* npm-4000-1r

* npm-4000-2s

* npm-4000-2e1

* npm-4000-2e

* npm-4000-2r1

* npm-4000-2r

* npm-4000-4t

* npm-4000-4b

* npm-4000-8b

* npm-4000-ct1

* npm-4000-ce1

* npm-4000-1a

* npm-4000-6e

* npm-4000-1fe

NETWORK MANAGEMENT PLATFORMS
************************************************
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The network management platforms supported are the same platforms that
are

available for CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* Sun workstation: SunNet Manager 2.2.2

* Sun workstation: Hewlett-Packard (HP) OpenView 3.3

* HP system: HP OpenView for UNIX 3.3

* AIX system: NetView for AIX 3.1 or 4.1

* PC: HP OpenView for Windows, 7.2b (C.02.17)

* PC: CastleRock SNMPc 4.1g with HP OpenView emulation support

See CAVEATS at the end of this ReadMe for important information regarding

HP OpenView for Windows.

OPERATING SYSTEMS
************************************************************

The Cisco 4000, Cisco 4500, Cisco 4700, and Cisco 2500 series device

package (*.pkg) currently runs on the same operating systems as CiscoView

3.1(1) and CiscoWorks Windows 2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),
or

  Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 or 4.1

* Windows 95 4.0

* Windows NT 3.51
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CISCO IOS SOFTWARE RELEASES
*************************************************

Cisco IOS Software Release 11.1 and earlier releases support Cisco 4000,

Cisco 4500, Cisco 4700, and Cisco 2500 series routers.

Note: Cisco IOS Releases 10.2 and 10.3 do not support all cards for the

Cisco 4000 series routers. All Cisco 4000 series routers are supported in

Cisco IOS Release 11.0 and later releases.

CURRENT DOCUMENTATION
*******************************************************

Look for these documents on the Cisco Connection Documentation,
Enterprise

Series CD-ROM:

Cisco 4000 series documentation:

Cisco 4000 Series Installation Guide

 (use for Cisco 4000-M, Cisco 4500-M, Cisco 4700-M)

Cisco 4000 Series Hardware Installation and Maintenance

 (use for Cisco 4700)

Cisco 4000 Hardware Installation and Maintenance

 (use for Cisco 4000 and Cisco 4500)

Cisco 4000 series configuration notes:
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Upgrading Memory in the Cisco 4000 and Cisco 4000-M

Upgrading the Cisco 4000 Flash EPROM Card (Cisco 4000)

Installing Network Processor Modules in the Cisco 4000 Series

Cisco 4000 Series Rack-Mount and Wall-Mount Installation

Upgrading System Software in the Cisco 4000 Series

Connecting the Cisco 4000 DC-Input Power Supply

Upgrading Cisco 4500, Cisco 4500-M, Cisco 4700, and Cisco 4700-M
Memory

Upgrading the Flash EPROM Memory Card (Cisco 4000)

Cisco 2500 series documentation:

Cisco 2500 Series Router Installation Guide

 (Cisco 2501-2504 and Cisco 2513-2515)

Cisco 2500 Series Hardware Installation and Maintenance

 (Cisco 2505, Cisco 2507, Cisco 2516)

Cisco 2500 Series Hardware Installation

 (Cisco 2505, Cisco 2507, Cisco 2516)

Cisco 2500 Series Access Server User Guide

 (Cisco 2509, Cisco 2510, Cisco 2511, Cisco 2512)

Cisco 2517 and Cisco 2519 Router/Hub User Guide

Cisco 2518 Router/Hub User Guide

Cisco 2500 Series Multiport Serial Router User Guide

 (Cisco 2520, Cisco 2521, Cisco 2522, Cisco 2523)

Cisco 2524 and Cisco 2525 Router User Guide

Cisco 2500 series configuration notes:
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- Upgrading the DRAM SIMM on the Cisco 2500 Series Routers

- Replacing the Boot ROMs in the Cisco 2500 Series and AccessPro PC Card

- Installing Dual Flash Memory SIMMs on the Cisco 2500 Series

- Upgrading Boot Image with Flash Memory Cards for Cisco 2500 Series
Routers

- Upgrading Feature Sets with Flash Cards for Cisco 2500 Series Routers

CiscoView and CiscoWorks Windows documentation:

* CiscoView 3.1.(1) Release Note

* CiscoView Incremental Installation Quick Reference

* CiscoView CD Installation Instructions

* CiscoWorks Windows 2.0(1) Release Note

* CiscoWorks Windows Incremental Installation Quick Reference

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

CAVEATS****************************************************
******************

Note: Caveats 1 through 4 apply only to Cisco 2500 series routers:

1. The Cisco 2520, Cisco 2521, Cisco 2522, and Cisco 2523 routers had a bug

in the agent implementation that affected CiscoView. This bug was fixed in

Cisco IOS Release 11.0(5) and 11.1(2.1). For CiscoView to work properly,

these routers must have a Cisco IOS Release 11.0(5.1) and 11.1(2.1) or

later.
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2. Cisco 2524 and Cisco 2525 routers have an extra MIB for the two
CSU/DSU

WAN cards. This MIB is implemented only in Cisco IOS Release 11.0(5).
These

routers can be viewed properly only if they have Cisco IOS Release 11.0(5)

or later.

3. Cisco 2524 and Cisco 2525 routers have two CSU/DSU WAN card slots.
Each

of the slots can contain any one of the following cards:

   * Two-wire switched 56K/64K

   * Four-wire switched 56K/64K

   * Fractional T1

   * 5-in-1 serial

   * Empty

Because of a bug in the MIB agent implementation, there is no way to

distinguish between the 5-in-1 card in a slot and an empty slot. In both

cases, CiscoView displays the 5-in-1 card gif. (The gif is the viewable

picture of the device and cards.)

4. Cisco 2524 and Cisco 2525 routers have a BRI card slot, which can

contain either a BRI card with an NT1 interface or a BRI card without an

NT1 interface. At present, there is no way to differentiate between these

two cards using the MIB. In both cases, CiscoView displays the BRI card

without the NT1 gif.
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5. The following Cisco Access devices require the current version of HP

OpenView for Windows, version 7.2b (C.02.17):

  Device Name:                            Tar Filename:

* CPA2520, CPA2522, CPA2524               2500.cv311.Px-x.tar

* CPA4500                                 4000.cv311.Px-x.tar

Previously we notified you of a problem with HP OpenView for Windows,
7.2b

(C.02.14), where CiscoView did not recognize the Access devices listed

above. HP fixed this problem. The fix for this problem requires that you

upgrade HP OpenView for Windows and run a conversion utility for any of
the

affected device packages you might have installed.

HP OpenView for Windows must be upgraded (first to C.02.15, then to

C.02.17) to work with the above devices. For details on upgrading HP

OpenView for Windows and running the required conversion utility, refer to

the CiscoWorks Release Note, version 2.1(1).

Cisco 7000 Series Device
12/2/96  7000.cv311.P3-0

CiscoView 3.1 Release Note Update for the Cisco 7000 Router Family.
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This readme file provides information about the Cisco Router 7000

incremental device support package version 3.1(3.0).  This package

supports the Cisco 7000, 7200, and 7500 Series Routers and replaces

the 7000 package version 3.1(2.1).

This readme file contains the following sections:

* P3-0 package contents

* Package Tar File

* CiscoView Release

* Operating System

* Current Documentation

* Caveats

* P2-1 package readme text

P3-0 PACKAGE CONTENTS
*****************************************************

This package contains new device support, new functionality, and

several bug fixes.

New Device Support:

-------------------

   * Cisco 7204 router

   * 7200 IO Card (without FE port)

   * CT3 Interface Processor card

   * Port Adapter cards

        o SA-Compression

        o PA-FDDI-MM-FD
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        o PA-FDDI-SM-FD

        o PA-H1T

        o PA-H2T

        o PA-4T

        o PA-8T-V35

New Functionality:

------------------

   * Flash File System Admin functionality for CiscoView on Windows NT

     systems (previously available only on Unix systems)

   * Cisco Compression Service Adapter MIB

         o SA-Compression Card Configure/Monitor categories

           - Card Configuration (Compression Enabled/Disabled)

           - Compression Statistics

   * Cisco IP Encryption MIB

         o Three new Device Configure software encryption categories:

           - Encryption Configuration

           - Encryption Engine Status Table

           - Encryption Connection Table

   * Enable/Normal LEDs on port adapters, interface processors, route

     processors (on routers running IOS version 11.1 or later)

         o LEDs are shown as green (on) or black (off) to simulate

           their appearance on the card.

   * Power Supply LEDs on 7000, 72xx, 7507, 7513

Bug Fixes:

----------
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   * Possibly misleading LED displays [CSCdi62760]

   * Poll for FDDI i/f SMT index [CSCdi62971]

   * Flash file size information is not updated [CSCdi63120]

   * Bad ifTable causes display problems [CSCdi66033]

   * 7010 SNM component record missing in P2-0 [CSCdi72507]

   * Incorrect utilization formula [CSCdi73927]

   * Incomplete device redraw after OIR event [CSCdi75019]

PACKAGE TAR FILE
*****************************************************

The tar file, 7000.cv311.P3-0.tar, includes the electronic network

management package file, 7000.pkg, that provides the support listed

above.  It also includes a copy of this readme file.

CISCOVIEW RELEASE
****************************************************

The CiscoView releases that support this package are CiscoView 3.1(1)

and CiscoView 3.2(1) for Unix and the PC.

OPERATING SYSTEM
*****************************************************

This package runs on all OS/NMS platform combinations that support

CiscoView 3.1(1) and 3.2(1).

CURRENT DOCUMENTATION
************************************************

- CiscoView 3.2(1) Release Notes

- CiscoView CD Installation Instructions
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- Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS****************************************************
***********

The following problems may be encountered while using this new package:

* FEIP and FE port adapters now display port status only on the

configured connector.  The other connector will appear gray.

* Flash File System functions:

  - Functions may fail if the host system hostname is not in DNS.

  - If a "Squeeze" operation fails, try increasing the timeout property

    under Options on the Main window.  The proper timeout value may

    vary according to network utilization.

  - To copy IOS image files with tftp format filenames (e.g.,

    patch/rsp-jv-mz.1028) from the local filesystem, be sure that the

    corresponding directory already exists on the remote file system.

  - The "Delete" function will fail if the RW community string is not

    properly set on the router or in CiscoView.

* With the introduction of the 7200, SunNet Manager and HP OpenView

network map icons identify a Cisco 7xxx router according to its

family, i.e., 7000, 7200, or 7500.  Icons no longer specifically

identify the 7000 or 7010 routers.  For SNMPc and OpenView Windows

a "7000" icon is used for all 7x00 router families.

* CT3 IP support in this package is limited to card-level configuration
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data.  No port specific data is available and the displayed connectors

will remain gray (no status).

* This package supports a new TN3270 Monitor program.  The program

itself is scheduled to be available in mid-December 1996 on CCO as a

separately downloadable/installable package.

* All cards in a chassis containing a SA-Compression card will offer a

Card Monitor category, even though this category applies only to the

SA-Compression card.  Invoking the Card Monitor category on another

card type results in a "monitors not available" message.  [CSCdi74396]

* Public Key field may overlap other fields of the Encryption Engine

Status Table on Windows platforms.  [CSCdi75662]

* Selecting Card Configure for a card displayed as an "Unknown Card"

gives a Tcl script error.  [CSCdi76091]

Cisco AS5200 Device

ReadMe File:

Update to CiscoView 3.1(1) and CiscoWorks Windows 2.0(1)--

Cisco AS5200 Universal Access Server Incremental Install: Release 2.0

This ReadMe file includes the following sections:

* Introduction
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* What's new

* Tar file (*.tar)

* MIB files

* CiscoView and CiscoWorks Windows releases

* Network management platforms

* Operating system

* Cisco Internetwork Operating System (Cisco IOS) release

* AS5200 Manager application

* Current documentation

* Caveats

* Installation

INTRODUCTION
*************************************************************
*

The Cisco AS5200 is a versatile data communications platform that provides

the functions of an access server, a router, and digital modems in a

modular chassis.

WHAT'S NEW
*************************************************************
**

Release 2.0 includes bug fixes, support for additional network management

platforms and operating systems, and support for the channelized E1/PRI

card.
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TAR FILE
*************************************************************
****

The tar file (*.tar) includes the electronic network management device

package file (*.pkg) that enables you to display and manage the Cisco

AS5200 using CiscoView and CiscoWorks Windows. The tar file also
includes a

copy of this ReadMe file.

MIB FILES
*************************************************************
***

Simple Network Management Protocol (SNMP) Management Information
Base (MIB)

files are available for network management.

AS5200 supports all MIBs that IOS supports, plus the Cisco Modem MIB
that was

first implemented in AS5200.

The following Cisco Connection Online (CCO) URL contains many MIBs:

ftp://ftp-eng.cisco.com/pub/mibs/supportlists/as5200/supportlist.html

CISCOVIEW AND CISCOWORKS WINDOWS RELEASES
*********************************

The supporting CiscoView release is CiscoView 3.1(1).
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The supporting CiscoWorks Windows release is CiscoWorks Windows
2.0(1).

NETWORK MANAGEMENT PLATFORMS
**********************************************

The network management platforms supported are the same platforms that
are

available for CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* UNIX: Sun workstation: SunNet Manager 2.2.2

* UNIX: Sun workstation: Hewlett-Packard (HP) OpenView 3.3

* UNIX: HP system: HP OpenView (HPOV) for UNIX 3.3

* UNIX: HP OpenView (HPOV) with Solaris

* UNIX: SunNet Manager (SNM) with Solaris

* UNIX: Standalone HP-UX and Sun UNIX

* AIX: NetView for AIX 3.1 or 4.1

* PC: HP OpenView for Windows 95 and Windows NT, Release 7.2b
(C.02.17)

* PC: CastleRock SNMPc 4.1g with HP OpenView emulation support with

      Windows 95 and Windows NT

* PC: Standalone Windows 95 and Windows NT

OPERATING SYSTEMS
*********************************************************

The Cisco AS5200 device package file (*.pkg) runs on the same operating

systems as CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):
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* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),
or

  Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 or 4.1

* Windows 95 4.0

* Windows NT 3.51

CISCO IOS RELEASE
********************************************************

Cisco IOS Release 11.1(5) supports the Cisco AS5200.

AS5200 MANAGER APPLICATION
***********************************************

The Cisco AS5200 package includes the AS5200 Manager application. The

AS5200 Manager application includes modem management, and enables you
to

remotely view, monitor, configure, and troubleshoot the AS5200 Universal

Access Server from within CiscoView.

CURRENT DOCUMENTATION
****************************************************

Look for the following documents on the Cisco Connection Documentation,

Enterprise Series CD-ROM:

Cisco AS5200 documentation:
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* Cisco AS5200 Universal Access Server Installation Guide

* Cisco AS5200 Universal Access Server Software Configuration Guide

* 12-Port Modem AT Command Set and Register Summary

* Cisco AS5200 Universal Access Server Installation Quick Reference Card

* Cisco AS5200 Universal Access Server Configuration Quick Reference
Card

* Cisco AS5200 Safety and Regulatory Compliance

* Cisco AS5200 Terminator Card Installation Note

* AS5200 Manager Guide (available only online on CCO)

CiscoView documentation:

* CiscoView 3.1.(1) Release Note

* CiscoView Incremental Installation Quick Reference

* CiscoView CD Installation Instructions

CAVEATS
*************************************************************
******

The following problems might occur while using CiscoView.

#1.

ID #: CSCdi68740 -

This release contains bug CSCdi68740, which causes devinst.exe to refuse to

reinstall the package (pkg) file in the Windows platform. The work around
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is to use the CiscoWorks Windows Uninstall Device option to uninstall the

AS5200 pkg file, and then use the CiscoWorks Windows Install Device option

to reinstall the AS5200 pkg file.

#2.

ID #: CSCdi73863 -

Some of the configuration popup windows for the port modules and daughter

cards show an error message "Unknown Card Type: xxx," where xxx is an

integer. This is caused by a problem with the CiscoView engine

(specifically snmpTcl). The error message means that CiscoView could not

translate the integer value xxx for the cardType MIB variable (obtained

from the router) into the enumeration defined in the chassis MIB.

INSTALLATION
*************************************************************

This section is divided into two parts:

* Installing on a UNIX Workstation quick reference

* Installing on a PC quick reference

Refer to the AS5200 Manager Guide on Cisco Connection Online (CCO) for

installation details. To access the guide, enter the following URL:

http://oracular/ucdrt/data/doc/hardware/access/5200/5200.htm
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For details on downloading to a UNIX workstation, see Chapter 2 of the

AS5200 Manager Guide.

For details on downloading to a PC, see Chapter 3 of the AS5200 Manager
Guide.

 ************ INSTALLING ON A UNIX WORKSTATION QUICK
REFERENCE ************

If you are installing on a UNIX workstation, you can access the Cisco

AS5200 device package file in two ways: from Cisco Connection Online
(CCO),

or by using the anonymous FTP service. Chapter 2 of the AS5200 Manager

Guide contains detail about both ways. A quick reference follows.

+++ DOWNLOADING FROM CISCO CONNECTION ONLINE (CCO)
+++

[1] Check the version of CiscoView.

[2] Close CiscoView.

[3] Create a cv_pkgs directory in the install_directory on your workstation.

[4] Change the default directory to cv_pkgs.

[5] Access CCO.

[6] Download the tar file onto your workstation.

[7] Untar the tar file.

[8] Add the package file to CiscoView.
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[9] Check the cvinstall.log file.

Details about the above steps are in the AS5200 Manager Guide.

+++ USING ANONYMOUS FTP TO DOWNLOAD THE TAR FILE +++

[1] Check the version of CiscoView.

[2] Close CiscoView.

[3] Create a cv_pkgs directory in the install_directory on your workstation.

[4] Change the default directory to cv_pkgs.

[5] Download the tar file into the cv_pkgs directory on your workstation.

[6] Untar the tar file.

[7] Add the package file to CiscoView.

[8] Check the cvinstall.log file.

Details about the above steps are in the AS5200 Manager Guide.

******************** INSTALLING ON A PC QUICK REFERENCE
*******************

If you are installing on a PC, you can access the Cisco AS5200 device

package file from Cisco Connection Online (CCO). Chapter 3 of the AS5200

Manager Guide contains detail. A quick reference follows.
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[1] Check the version number of CiscoView and CiscoWorks Windows.

[2] Close CiscoView.

[3] Create a cv_pkgs directory in the CWW directory on your PC.

[4] Access CCO.

[5] Download the tar file into the cv_pkgs directory.

[6] Unzip the tar file.

[7] Add the package file to CiscoView.

[8] View your device.

[9] Optionally, delete the cv_pkgs directory.

Details about the above steps are in the AS5200 Manager Guide.

Cisco Catalyst 1200 Device
This ReadMe file describes the Cisco Catalyst 1200  device

package, and associated:

* network management platforms

* operating systems

* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support
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OPERATING SYSTEMS

The Cisco Catalyst 1200  device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

     or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

Cisco software release 4.1 for the Catalyst 1200

NEW FEATURES

This device package extends the CiscoView device manager to include
support for:

*  CDP (Cisco Discovery Protocol) configuration

*  VTP (VLAN Trunk Prootocol) configuration

*  CiscoView launch of Traffic Director for RMON capable switches

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Please refer to the "Release notes for CWSI UNIX Version 1.0", Document

Number 78-3337; for additional information about CiscoView 3.1 and

Traffic Director.
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If CiscoView 3.1.1 is installed on an HP OpenView platform, theCiscoView

application will query and use the device's community name settings from

HPOV, whether CiscoView is launched from the command line or from the

HPOV main menu.  When this is done through HPOV, any further standalone

invocation of CiscoView will take the community string from HPOV until

the nmcview script exports the platform.

The IP Route device configuration window is not scrollable.  Use the

numbered arrow keys to scroll the window.

When using the Switch Zoom menu from CiscoView to view multiple switch

ports, the default configuration for the Catalyst 1200 is to configure

Statistics, Short-Term history, Long-Term history, and Host group.

For the Catalyst 5000, the default configuration is to configure

Statistics only. To see the short-term or long-term history from

traffic monitor, use the Domain Manager to configure the short-term

and long-term group manually or use Segment Zoom to view the port first.

When using the Segment Zoom menu from CiscoView to view the port

segment, the default configuration for the Catalyst 1200 is to configure

the Statistics, Short-Term history, Long-Term history and Host group.

For the Catalyst 5000 it is Statistics, Short-Term history, and

Long-Term history.

If you get the "Error: Entry or Group not present in Agent" message when

invoking Segment Zoom, Switch Zoom, or Data Capture, the write
community

string may not be matched with the device.  If the community string is

matched and the problem still happens, use the CiscoView Configure

Device menu to see if the RMON capability is enabled or not.

When you select the repeater module port on a Catalyst 5000, it always
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uses the first port of the selected segment to create the RMON agent

group. If you see "IP address is not set in sysIpAddr Mib variable,"

it is because the Catalyst 1200 SNMP agent does not store the correct

IP address in the sysIpAddr MIB variable, so you have to use CiscoView

to correct it.  Go to Configure>Device, enter the correct IP address

in the corresponding field, and click Modify.

Cisco Catalyst 1800 Device
12/16/96

CiscoView 3.1(1) and CiscoWorks Windows -- Incremental Install for the
Cisco

Catalyst 1800 Device Package [version 1.0]

This README file includes the following sections:

* Introduction

* Network Management platforms

* Operating Systems

* CISCO Catalyst 1800 SYSTEM SOFTWARE RELEASES

* Tar file (*.tar)

* Current documentation available

* Caveats, if any

* Changes from the earlier release of the package

INTRODUCTION

The Catalyst 1800 Token Ring Switch is a token ring, packet-switching
device
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that dramatically increases performance, flexibility, and management on
token

ring installations.

NETWORK MANAGEMENT PLATFORMS

The Network Management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.3

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView 3.1 or NetView 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

1. SUN running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_UI, or SunOS 4.1.4),
or

Solaris 2.4 with recommended patches as of 3/16/95

2. HP running HP-UX A.09.03/A.09.04/A.09.05

3. AIX 3.2.5(1) or 4.1

4. Windows 95 4.0

5. Windows NT 3.51

CISCO Catalyst 1800 SYSTEM SOFTWARE RELEASES
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This package is compatible with System Firmware Version TRX/FDU.2.1.10
or

above.

TAR FILE

The tar file (*.tar) includes the electronic network management device
package

file (*.pkg) that enables you to view and manage Catalyst 1800 using
CiscoView

and CiscoWorks Windows.  The tar file also contains a copy of this README
file.

Files available from the Network Management Support CD are not in the .tar

format and do need not be untarred.

CURRENT DOCUMENTATION AVAILABLE

* Catalyst 1800 Token Ring Switch User Guide

* Catalyst 1800 Token Ring Switch FDU module Installation Guides

* Catalyst 1800 Token Ring Switch Customer Release Notes

* CiscoView 3.1.(1) Release Note

* CiscoView Incremental Installation Quick Reference

* CiscoView 3.1 (1) CD Installation Instructions

* CiscoWorks Windows 2.0(1) Release Note
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* CiscoWorks Windows Incremental Installation Quick Reference

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

CAVEATS

1.  The device agent does not update the IP Address Table of MIB-II properly

    and does not reflect the correct IP Address information of all the device

    interfaces.  So, the user will not be able to view the correct IP Address

    information of the device through Device->Configure->IP Address Table.

2.  The user will not be able to create new static entries for IP Route Table

    and ARP Table through CiscoView.

3.  In the interface configuration (Port->Config->Interface), modification of

    the IP parameters always results in an error message being displayed, but

    the modification is done successfully.

4.  The user will not be able to change the bridge type of the FDDI port to

    sr-only or srt.

5.  The user will not be able to change the bridge type of the TR port to

    srtb or tb-only.

6.  The system time configuration is not included as part of device

    configuration.

CHANGES FROM THE EARLIER (BETA) RELEASE

1.  In the VLAN Configuration, the user can create the VLANs by specifying
the

    logical segment numbers and/or physical port numbers.
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Cisco CPW16 Device
This ReadMe file describes the Cisco CPW16  device

package, and associated:

* network management platforms

* operating systems

* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

The Cisco CPW16  device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

Cisco software release 1.1 for the CPW16.

NEW FEATURES
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This device package extends the CiscoView device manager to include:

*  Support for CDP configuration

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Please refer to the "Release notes for CWSI UNIX Version 1.0", Document

Number 78-3337; for additional information about CiscoView 3.1 and

Traffic Director.

If CiscoView 3.1.1 is installed on an HP OpenView platform, theCiscoView

application will query and use the device's community name settings from

HPOV, whether CiscoView is launched from the command line or from the

HPOV main menu.  When this is done through HPOV, any further standalone

invocation of CiscoView will take the community string from HPOV until

the nmcview script exports the platform.

The IP Route device configuration window is not scrollable.  Use the

numbered arrow keys to scroll the window.

Cisco CPW1220, CPW1420, Cat1900, and Cat2820 Devices
This ReadMe file describes the Cisco CPW1220, CPW1420,

Cat1900, and Cat2820 device packages, and associated:

* network management platforms

* operating systems
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* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

These device packages currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

The switches must be running software release 1.0 or later.

NEW FEATURES

These new device packages extends the CiscoView device manager to support

management of Cisco EtherSwitch 1220, EtherSwitch 1420, Catalyst 1900,

and Catalyst 2820.

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note
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* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

In the front panel display of the Cat 2820 and CPW 1420, the Connect

and Disabled LEDs on FDDI modules do not reflect the appropriate

status.

CPW 1420, Cat 2820-Do not attempt to invoke the Monitoring menu for an
FDDI

port or a repeater port. There is no monitoring function provided for these

ports, although the pull-down menu is enabled when such ports are selected.

CPW 1420, Cat 2820-The Configure Module Windows do not work when
more than

one module type is selected. Select only one module type before opening

these windows.

CPW 1220, CPW 1420, Cat 1900, Cat 2820-The General Bridge window
shows the

bridge information for VLAN1 only. Bridge information for other VLANs is

not available.

CPW 1220, CPW 1420, Cat 1900, Cat 2820-The Spanning Tree Protocol
Window

for switched ports is available for ports in VLAN1 only. This window does

not show valid information for ports not in VLAN1.

These packages do not show version information in the About CiscoView

dialog box. In these cases, the CiscoView About dialog box displays

the package version only. However, the version information is displayed
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in the "Packages Installed" list.

Cisco CPW2200 Device
Changes from Cisco CPW2200.cv311.1-1:

        -  Minor modification to the CISCO-STACK-MIB; no functional change.

This ReadMe file describes the Cisco CPW2200  device

package, and associated:

* network management platforms

* operating systems

* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

The CiscoPro 2200  device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95, 4.0
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* Windows NT, 3.51

CISCO SOFTWARE RELEASES

Cisco software releases 2.1 for the Cisco CPW2200.

NEW FEATURES

This device package extends the CiscoView device manager to include
support for:

*  CDP (Cisco Discovery Protocol) configuration

*  VTP (VLAN Trunk Prootocol) configuration

*  CiscoView launch of Traffic Director for RMON capable switches

*  WS-X5020: 48 port 10BaseT Group Switching Ethernet Module

*  WS-X5011:  12 port 10Base FL module

*  WS-X5213:  12 port 10/100 Base TX module

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Please refer to the "Release notes for CWSI UNIX Version 1.0", Document

Number 78-3337; for additional information about CiscoView 3.1 and Traffic

Director.

If CiscoView 3.1.1 is installed on an HP OpenView platform, the CiscoView

application will query and use the device's community name settings from

HPOV, whether CiscoView is launched from the command line or from the

HPOV main menu.  When this is done through HPOV, any further standalone
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invocation of CiscoView will take the community string from HPOV until

the nmcview script exports the platform.

The IP Route device configuration window is not scrollable.  Use the

numbered arrow keys to scroll the window.

Under a heavy load condition, CiscoPro 2200 SNMP responses are slow.

You may see an "error, no response since...." message in the

CiscoView status window.  Select Options>Properties and increase

the Polling Frequency and Timeout values. [CSCdi57962]

Do not use the Grapher in the CiscoView Monitor "10BaseT Group
Switching

Ethernet" window.  Use the Monitor or Traffic Director tools to see

graphical views of the selected repeater ports.

The embedded RMON agent in the CiscoPro 2200 only supports the Ethernet

Statistics and Ethernet History Groups.  Data Capture and Host List do

not work on the CiscoPro 2200.

For the CiscoPro 2200, if the number of the embedded RMON agent is

over 50,you cannot create any new embedded RMON agent group for

the new port. Use the Domain Manager to deinstall the agent group

from the unused port to free the memory resource.

When you select the repeater module port on a CiscoPro 2200, it always

uses the first port of the selected segment to create the RMON agent

group.  If you see "IP address is not set in sysIpAddr Mib variable,"

it is because the Catalyst 1200 SNMP agent does not store the correct

IP address in the sysIpAddr MIB variable, so you have to use CiscoView

to correct it.  Go to Configure>Device, enter the correct IP address

in the corresponding field, and click Modify.
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Cisco Catalyst 2600 Device
This ReadMe file describes the Cisco Catalyst 2600 device

package, and associated:

* network management platforms

* operating systems

* current documentation available

* Changes for the release, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.3

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

The Cisco Catalyst 2600 device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95, 4.0

* Windows NT, 3.51

CISCO Catalyst 2600 SYSTEM SOFTWARE RELEASES

This package has been verified with system software version SR-2.0.6 and
SR-2.2.1.

CURRENT DOCUMENTATION AVAILABLE



Cisco Network Management Support CD README (January 1997)  75

README Files for Device Support

* Catalyst 2600 Token Ring Switch User Guide

* 2-Port Token Ring Fiber Universal Feature Card Planning and

        Installation Guide

* 4-Port Token Ring UTP/STP Universal Feature Card Planning and

        Installation Guide

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CHANGES FOR THE RELEASE

1.  The device package contains two versions of the enterprise mibs for
Catalyst 2600 switch.

    C2600_cisc.my -- This mib file is installed to support devices with

image versions prior to 2.2.1.

    C2600.my -- This mib file is installed to support devices with

image version 2.2.1 or later.

    When the user is using a MIB browser tool, he will see the mib

variables defined in each of the above,  under different branches,

at the same time, though any particular Catalyst 2600 switch will

respond to queries on only one of the mibs based upon the release of

software in the device.  Cisco recommends that you upgrade your Catalyst
2600

switches to version 2.2.1 or later.

Cisco Catalyst 2900 Device
Update to CiscoView 3.1(1) -- Incremental Install for the Cisco Catalyst
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2900 Device Package

Changes from Cat 2900.cv311.1-1:

-  Minor modification to the CISCO-STACK-MIB; no functional change.

This ReadMe file describes the Cisco Catalyst 2900  device

package, and associated:

* network management platforms

* operating systems

* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView for AIX 3.1 or 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS
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The Cisco Catalyst 2900  device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

Cisco software releases 2.1 for the Catlyst 2900.

NEW FEATURES

This device package extends the CiscoView device manager to include
support for:

*  CDP (Cisco Discovery Protocol) configuration

*  VTP (VLAN Trunk Prootocol) configuration

*  CiscoView launch of Traffic Director for RMON capable switches

*  WS-X5020: 48 port 10BaseT Group Switching Ethernet Module

*  WS-X5011:  12 port 10Base FL module

*  WS-X5213:  12 port 10/100 Base TX module

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions
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* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Please refer to the "Release notes for CWSI UNIX Version 1.0", Document

Number 78-3337; for additional information about CiscoView 3.1 and Traffic

Director.

If CiscoView 3.1.1 is installed on an HP OpenView platform, the CiscoView

application will query and use the device's community name settings from

HPOV, whether CiscoView is launched from the command line or from the

HPOV main menu.  When this is done through HPOV, any further standalone

invocation of CiscoView will take the community string from HPOV until

the nmcview script exports the platform.

The IP Route device configuration window is not scrollable.  Use the

numbered arrow keys to scroll the window.

Under a heavy load condition, Catalyst 2900 SNMP responses are slow.

You may see an "error, no response since...." message in the

CiscoView status window.  Select Options>Properties and increase

the Polling Frequency and Timeout values. [CSCdi57962]

Do not use the Grapher in the CiscoView Monitor "10BaseT Group
Switching

Ethernet" window.  Use the Monitor or Traffic Director tools to see
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graphical views of the selected repeater ports.

The embedded RMON agent in the Catalyst 2900 only supports the Ethernet

Statistics and Ethernet History Groups.  Data Capture and Host List do

not work on the Catalyst 2900.

For the Catalyst 2900, if the number of the embedded RMON agent is

over 50,you cannot create any new embedded RMON agent group for

the new port. Use the Domain Manager to deinstall the agent group

from the unused port to free the memory resource.

When you select the repeater module port on a Catalyst 2900, it always

uses the first port of the selected segment to create the RMON agent

group.  If you see "IP address is not set in sysIpAddr Mib variable,"

it is because the Catalyst 1200 SNMP agent does not store the correct

IP address in the sysIpAddr MIB variable, so you have to use CiscoView

to correct it.  Go to Configure>Device, enter the correct IP address

in the corresponding field, and click Modify.

Cisco Catalyst 3000 Series Device
This device package extends the CiscoView device manager to include:

*  VTP/VLAN configuration

*  ATM LANE LEC configuration

*  Support for WS-X3011  router blade

***************************IMPORTANT**********************
***********
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This package supports the WS-X3011 router blade. This router is a

2500 series router and is managed by the 2500.pkg. For this release

the 2500.pkg *MUST* be installed before the Cat3000.pkg. If this step

is not followed, the Cat3000.pkg will fail to install.

*************************************************************
********

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView 3.2.1 or 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

The Cisco Catalyst 3000  device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

      or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 and 4.1

* Windows 95, 4.0
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* Windows NT, 3.51

CISCO SOFTWARE RELEASES

The following firmware versions are supported:

CPW1601                  v. 2.0

Catalyst 3000            v. 1.0, 1.1, 1.3, 2.0

Catalyst 3200            v. 1.0, 1.1, 1.3, 2.0

MIB FILES

Check Cisco Connection Online at the following URL for published

MIBs for this product: ftp://ftp-eng.cisco.com/pub/mibs/supportlists

TAR FILES

The following .tar file contains the ".pkg" file for the

Catalyst 3000:    Cat3000.cv311.2-0.tar

DEVICES SUPPORTED

* CPW16

* Catalyst 3000

* Catalyst 3200

NETWORK PROCESSOR MODULES SUPPORTED

* WS-X3011

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note
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* CiscoWorks Windows 2.0(1) Release Note

* CWSI 1.1 Release Notes

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Due to restriction in the CiscoView 3.1 engine, when the Catalyst 3200

is viewed using CiscoView it does not follow the traditional "real life"

display model for CiscoView device support. The display shows all

Catalyst 3200 modules compacted into a two slot chasis, with module

numbers increasing from left to right and top to bottom.

When changing the setting for Full/Half duplex on an ISL port the

change is not always reported correctly. This is due to a problem

in the Catalyst 3000 2.0 software and will be rectified in the next

release. [CSCdi74294]

When accessing a stack with six or more devices, there may be some

significant performance problems. The performance can be improved

by increasing the SNMP timeout settings.

It is not possible to drag and drop a port to a VLAN which does not

already have ports associated with it. This is due to a problem in

the Catalyst 3000 2.0 software and will be rectified in the next

release. For this release, use the CLI on the Cat3000 to assign the
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first port to a VLAN. [CSCdi77035]

The Catalyst 3000 software does not support RMON on either a stack or

an ATM port.

The coloring of ports on the router module according to port status

is not supported in this release. If you wish to manage the router

module, use the right mouse button and select the "CiscoView Router"

menu then use the left mouse button to launch another CiscoView

session to manage the router.

The Catalyst 3000 software does not allow the modification of the

Parent VLAN number. [CSCdi76775]

The SAID value entered when creating an FDDI VLAN is redisplayed

as a different value. The VLAN was however created with the correct

value. This is due to a bug in the Catalyst 2.0 software and will

be rectified in the the next release.

Cisco Catalyst 5000 Device
Update to CiscoView 3.1(1) -- Incremental Install for the Cisco Catalyst

5000 Device Package

Changes from the Cat5000.cv311.1-1 version:

-  Minor modifcations to the CISCO-STACK-MIB; no functional changes.

-  bug fixes CSCdi60318, CSCdi65210, CSCdi64581
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-  Enhancement to the bitmap for the 100BaseTX module100BaseT

This ReadMe file describes the Cisco Catalyst 5000  device

package, and associated:

* network management platforms

* operating systems

* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView for AIX 3.1 or 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

The Cisco CAtalyst 5000 device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),
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    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 and 4.1

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

Cisco software releases 1.4, 1.5 and 2.1 for the Catlyst 5000.

NEW FEATURES

This device package extends the CiscoView device manager to include
support for:

*  CDP (Cisco Discovery Protocol) configuration

*  VTP (VLAN Trunk Prootocol) configuration

*  CiscoView launch of Traffic Director for RMON capable switches

*  WS-X5020: 48 port 10BaseT Group Switching Ethernet Module

*  WS-X5005: NMP with 2 port 100Base FX SingleMode fiber

*  WS-X5006: NMP with 2 port 100Base FX MultiMode fiber

*  WS-X5011:  12 port 10Base FL module

*  WS-X5213:  12 port 10/100 Base TX module

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions
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* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Please refer to the "Release notes for CWSI UNIX Version 1.0", Document

Number 78-3337; for additional information about CiscoView 3.1 and

Traffic Director.

If CiscoView 3.1.1 is installed on an HP OpenView platform, theCiscoView

application will query and use the device's community name settings from

HPOV, whether CiscoView is launched from the command line or from the

HPOV main menu.  When this is done through HPOV, any further standalone

invocation of CiscoView will take the community string from HPOV until

the nmcview script exports the platform.

The IP Route device configuration window is not scrollable.  Use the

numbered arrow keys to scroll the window.

Under a heavy load condition, Catalyst 5000 SNMP responses are slow. You

may see an "error, no response since...." message in the CiscoView

status window.  Select Options>Properties and increase the Polling

Frequency and Timeout values. [CSCdi57962]

Do not use the Grapher in the CiscoView Monitor "10BaseT Group
Switching
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Ethernet" window.  Use the Monitor or Traffic Director tools to see

graphical views of the selected repeater ports.

The embedded RMON agent in the Catalyst 5000 only supports the Ethernet

Statistics and Ethernet History Groups.  Data Capture and Host List do

not work on the Catalyst 5000.

When using the Switch Zoom menu from CiscoView to view multiple switch

ports, the default configuration for the Catalyst 1200 is to configure

Statistics, Short-Term history, Long-Term history, and Host group.

For the Catalyst 5000, the default configuration is to configure

Statistics only. To see the short-term or long-term history from

traffic monitor, use the Domain Manager to configure the short-term

and long-term group manually or use Segment Zoom to view the port

first.

When using the Segment Zoom menu from CiscoView to view the port

segment, the default configuration for the Catalyst 1200 is to

configure the Statistics, Short-Term history, Long-Term history

and Host group.  For the Catalyst 5000 it is Statistics, Short-Term

history, and Long-Term history.

If you get the "Error: Entry or Group not present in Agent" message when

invoking Segment Zoom, Switch Zoom, or Data Capture, the write
community

string may not be matched with the device.  If the community string is

matched and the problem still happens, use the CiscoView Configure
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Device menu to see if the RMON capability is enabled or not.

For the Catalyst 5000, if the number of the embedded RMON agent is over

50, you cannot create any new embedded RMON agent group for the new
port.

Use the Domain Manager to deinstall the agent group from the unused port

to free the memory resource.

When you select the repeater module port on a Catalyst 5000, it always

uses the first port of the selected segment to create the RMON agent

group.  If you see "IP address is not set in sysIpAddr Mib variable,"

it is because the Catalyst 1200 SNMP agent does not store the correct

IP address in the sysIpAddr MIB variable, so you have to use CiscoView

to correct it.  Go to Configure>Device, enter the correct IP address

in the corresponding field, and click Modify.

Cisco CPW10-100, CPW1200, CPW1400, Catalyst 1700, Catalyst 2100, and
Catalyst 2800

This ReadMe file describes the Cisco CPW10-100, CPW1200, CPW1400,

Cat1700, Cat2100, Cat2800 device packages, and associated:

* network management platforms

* operating systems

* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for
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CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView for AIX 3.1 or 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

These device packages currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 or 4.1

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

The following firmware versions are required:

Catalyst 2100 and 2800                  v. 3.63 or higher

EtherSwitch 1200 and 1400               v. 3.63 or higher

Grand Junction FastSwitch 2100 and 2800 v. 3.62 or higher
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NOTE: The Grand Junction FastSwitch 2100 and 2800 are managed the same
as

the Catalyst 2100 and 2800 respectively.

EtherSwitch 10/100                      v. 1.38 or higher

Catalyst 1700                           v. 1.38 or higher

Grand Junction FastSwitch 10/100        v. 1.37 or higher

NEW FEATURES

These device packages extend the CiscoView device manager to include:

*  Display of port status colors for Cisco EtherSwitch 10/100,

   EtherSwitch 1200, EtherSwitch 1400, Catalyst 1700, Catalyst 2100,

   and Catalyst 2800.

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

In the front panel display of the Cat 2800 and CPW 1400, the
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Connect and Disabled LEDs on FDDI modules do not reflect the appropriate

status.

CPW 1400, Cat 2800-Do not attempt to invoke the Monitoring menu for an
FDDI

port or a repeater port. There is no monitoring function provided for these

ports, although the pull-down menu is enabled when such ports are selected.

CPW 1400, Cat 2800-The Configure Module Windows do not work when
more than

one module type is selected. Select only one module type before opening

these windows.

CPW 1200, CPW 1400, Cat 2100, Cat 2800-The General Bridge window
shows the

bridge information for VLAN1 only. Bridge information for other VLANs is

not available.

CPW 1200, CPW 1400, Cat 2100, Cat 2800-The Spanning Tree Protocol
Window

for switched ports is available for ports in VLAN1 only. This window does

not show valid information for ports not in VLAN1.

The CPW10-100 do not show version information in the About CiscoView

dialog box. In these cases, the CiscoView About dialog box displays the
package version only. However, the version information is displayed

in the "Packages Installed" list.
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Cisco CPW2200 Device
Changes from CiscoPro 2200.cv311.1-1:

-  Minor modification to the CISCO-STACK-MIB; no functional change.

This ReadMe file describes the CiscoPro 2200  device

package, and associated:

* network management platforms

* operating systems

* current documentation available

* caveats, if any

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView for AIX 3.1 or 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

The CiscoPro 2200  device package currently runs on the
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same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 or 4.1

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

Cisco software releases 2.1 for the CiscoPro 2200.

NEW FEATURES

This device package extends the CiscoView device manager to include
support for:

*  CDP (Cisco Discovery Protocol) configuration

*  VTP (VLAN Trunk Prootocol) configuration

*  CiscoView launch of Traffic Director for RMON capable switches

*  WS-X5020: 48 port 10BaseT Group Switching Ethernet Module

*  WS-X5011:  12 port 10Base FL module

*  WS-X5213:  12 port 10/100 Base TX module

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions
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* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Please refer to the "Release notes for CWSI UNIX Version 1.0", Document

Number 78-3337; for additional information about CiscoView 3.1 and Traffic

Director.

If CiscoView 3.1.1 is installed on an HP OpenView platform, the CiscoView

application will query and use the device's community name settings from

HPOV, whether CiscoView is launched from the command line or from the

HPOV main menu.  When this is done through HPOV, any further standalone

invocation of CiscoView will take the community string from HPOV until

the nmcview script exports the platform.

The IP Route device configuration window is not scrollable.  Use the

numbered arrow keys to scroll the window.

Under a heavy load condition, CiscoPro 2200 SNMP responses are slow.

You may see an "error, no response since...." message in the

CiscoView status window.  Select Options>Properties and increase

the Polling Frequency and Timeout values. [CSCdi57962]

Do not use the Grapher in the CiscoView Monitor "10BaseT Group
Switching

Ethernet" window.  Use the Monitor or Traffic Director tools to see



Cisco Network Management Support CD README (January 1997)  95

README Files for Device Support

graphical views of the selected repeater ports.

The embedded RMON agent in the CiscoPro 2200 only supports the Ethernet

Statistics and Ethernet History Groups.  Data Capture and Host List do

not work on the CiscoPro 2200.

For the CiscoPro 2200, if the number of the embedded RMON agent is

over 50,you cannot create any new embedded RMON agent group for

the new port. Use the Domain Manager to deinstall the agent group

from the unused port to free the memory resource.

When you select the repeater module port on a CiscoPro 2200, it always

uses the first port of the selected segment to create the RMON agent

group.  If you see "IP address is not set in sysIpAddr Mib variable,"

it is because the Catalyst 1200 SNMP agent does not store the correct

IP address in the sysIpAddr MIB variable, so you have to use CiscoView

to correct it.  Go to Configure>Device, enter the correct IP address

in the corresponding field, and click Modify.

Cisco Catalyst WG-Concentrator Device
This readme file describes the Cisco Catalyst WG-Concentrator

device package with support for the following new features:

*  WS-X1431: 4 port Multi Mode FDDI (MIC connector)

*  WS-X1450: 2 port MM FDDI (MIC), 12 port CDDI (RJ-45)

NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):



96 Cisco Network Management Support CD README (January 1997)

README Files for Device Support

* On a Sun workstation: SunNet Manager, 2.2.2

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView, 3.2.1, 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

The Cisco Catalyst WG-Concentrator device package currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 and 4.1

* Windows 95, 4.0

* Windows NT, 3.51

MIB FILES

Check Cisco Connection Online at the following URL for published

MIBs for this product: ftp://ftp-eng.cisco.com/pub/mibs/supportlists

TAR FILES

The following .tar file contains the ".pkg" file for the

WG_Concentrator : WG_Concentrator.cv311.1-2.tar

DEVICES SUPPORTED

* Cat1000

* Cat1100

* Cat1400
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CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

If CiscoView 3.1.1 is installed on an HP OpenView platform, theCiscoView

application will query and use the device's community name settings from

HPOV, whether CiscoView is launched from the command line or from the

HPOV main menu.  When this is done through HPOV, any further standalone

invocation of CiscoView will take the community string from HPOV until

the nmcview script exports the platform.

Cisco LS1010 Device
The document discusses the LS1010 device and information about its use
with

 specific network management platforms and operating systems, Cisco IOS

Software Releases, applets supported, and any caveats that may exist.

NETWORK MANAGEMENT PLATFORMS

The LS1010 device package will run under the following Network
Management

platforms:

Sun OS    :  SunNet Manager 2.2.2, HPOV 3.3

Solaris   : SunNet Manager 2.2.2, HPOV 3.3

HPUX      : HPOV 3.3
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Win 95/NT : CastleRock SNMPc

Cisco IOS Software Releases

Cisco Software Release 11.1, IISP release for LS1010.

CURRENT DOCUMENTATION AVAILABLE

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

Caveats

OAM ping functionality is grayed out since this is not available

yet in the 11.1, IISP release for LS1010.

Cisco Fasthub 100+ Series
NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.3

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView, 3.2.1, 4.1

* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

These device packages currently runs on the
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same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 and 4.1

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

The following firmware versions are required:

Fasthub 100+              v. 1.12 or higher

MIB FILES

Check Cisco Connection Online at the following URL for published

MIBs for this product: ftp://ftp-eng.cisco.com/pub/mibs/supportlists

TAR FILES

The following .tar file contains the ".pkg" file for the

Fasthub 100+: FHUB_100+.cv311.1-0.tar

DEVICES SUPPORTED

* Fasthub 100+

NETWORK PROCESSOR MODULES SUPPORTED

* ws-x116

* ws-c116-nmm

CURRENT DOCUMENTATION

* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions
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* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Since Sun NetManager does not install the RMON MIB by default, RMON

TRAPs received by SNM are not listed. To avoid this problem please

manually load the RMON MIB in Sun NetManager. CSCdi77418

Sun NetManager does not correctly interpret the Logon Intrusion TRAP.

SNM lists it as a Reload TRAP. To avoid this problem, edit the

snmp.traps file manually and move the Reload Trap definition to the

bottom of the file. CSCdi77421

For device that have an expansion module, the port numbering is

not consistent with the management console. Ports 17 thru 32 are

listed in CiscoView as Repeater 2: Port 1 thru 16. CSCdi77159

After the first reset of the Fasthub 100+, the user must set the

'rptrReset' MIB variable to 'noReset' (default value) before

the next reset can be performed. This is due to a problem on

the Fasthub 100+ device software and will be fixed in a later

release. CSCdi77452

Cisco Netbeyond Fasthub 300 Series
NETWORK MANAGEMENT PLATFORMS

The network management platforms are the same platforms available for

CiscoView 3.1(1) and CiscoWorks Windows 2.0(1):

* On a Sun workstation: SunNet Manager, 2.2.3

* On a Sun workstation: Hewlett-Packard (HP) OpenView, 3.3

* On an HP system: HP OpenView, 3.3

* On an AIX system: NetView, 3.2.1, 4.1
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* On a PC: HP OpenView for Windows, 7.2b (C.02.14 or 2.14)

* On a PC: CastleRock SNMPc, 4.1g with HP OpenView emulation support

OPERATING SYSTEMS

These device packages currently runs on the

same operating systems as CiscoView 3.1(1) and CiscoWorks Windows
2.0(1):

* Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4),

    or Solaris 2.4 with recommended patches as of 3/16/95

* HP running HP-UX A.09.03/A.09.04./A.09.05

* AIX, 3.2.5 and 4.1

* Windows 95, 4.0

* Windows NT, 3.51

CISCO SOFTWARE RELEASES

The following firmware versions are required:

Netbeyond Fasthub 300      v. 1.12 or higher

MIB FILES

Check Cisco Connection Online at the following URL for published

MIBs for this product: ftp://ftp-eng.cisco.com/pub/mibs/supportlists

TAR FILES

The following .tar file contains the ".pkg" file for the Netbeyond

Fasthub 300: NETBEYOND_FHUB_300.cv311.1-0.tar

DEVICES SUPPORTED

* Netbeyond Fasthub 300

NETWORK PROCESSOR MODULES SUPPORTED

* cpw3116-x

* cpw300-nmm

CURRENT DOCUMENTATION
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* CiscoView 3.1.(1) Release Note

* CiscoWorks Windows 2.0(1) Release Note

* CiscoView CD Installation Instructions

* CiscoWorks Windows CD Installation Instructions

* CiscoWorks Windows Getting Started Guide

* Downloading New Cisco Devices and Applications (quick reference card)

CAVEATS

Since Sun NetManager does not install the RMON MIB by default, RMON

TRAPs received by SNM are not listed. To avoid this problem please

manually load the RMON MIB in Sun NetManager. CSCdi77418

Sun NetManager does not correctly interpret the Logon Intrusion TRAP.

SNM lists it as a Reload TRAP. To avoid this problem, edit the

snmp.traps file manually and move the Reload Trap definition to the

bottom of the file. CSCdi77421

For device that have an expansion module, the port numbering is

not consistent with the management console. Ports 17 thru 32 are

listed in CiscoView as Repeater 2: Port 1 thru 16. CSCdi77159

After the first reset of the Netbeyond Fasthub 300, the user must

set the 'rptrReset' MIB variable to 'noReset' (default value) before

the next reset can be performed. This is due to a problem on

the Netbeyond Fasthub 300 device software and will be fixed in a later

release. CSCdi77452

Threshold Manager Application
This README file includes the following sections:

* Introduction

* Network Management platform
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* Operating systems

* Tar file or ZIP file

* Supported Devices

* Current documentation

* Caveats

INTRODUCTION

Threshold Manager is a CiscoView-launched threshold management
application

that monitors the availability and performance of Cisco devices.

NETWORK MANAGEMENT PLATFORMS

The Cisco network management application used to launch Threshold
Manager

is CiscoView 3.1(1.0).

OPERATING SYSTEMS

Sun running Solaris 1.x (SunOS 4.1.3, SunOS 4.1.3_U1, or SunOS 4.1.4), or

Solaris 2.4 with recommended patches as of 3/16/95

HP running HP-UX 09.05, HP-UX10.01

NetView for AIX3.2, AIX4.2

Windows 95 4.0

Windows NT 3.51

Notes: To execute Threshold Manager in standalone mode (not launched from

CiscoView):

1. On Windows NT,

if the NetPlus WinSNMP icon still shows after all

instances of Threshold Manager have been exited, you will also need to

exit NetPlus WinSNMP. This will ensure that the NetPlus SNMP stack is

in sync with Threshold Manager.

2. On SUNOS,
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the user should set the environmental variables before executing

Threshold Manager from command line:

C Shell:

setenv XNLSPATH <Threshold Manager Directory>/nls

setenv XKEYSYMDB <Threshold Manager directory>/nls/XKeysymDB

Bourne/Korn shell:

export XNLSPATH = <Threshold Manager directory>/nls

export XKEYSYMDB = <Threshold Manager directory>/nls/XKeysymDB

3. On UNIX platforms,

The Hyperhelp needs the environment variable HHHOME to be set to

<CiscoView Directory>/hyperhelp. Also ensure that the environment

variable LD_LIBRARY_PATH is set.

TAR FILE

The TM-SOL.cv311.P1-1.tar file (Solaris), TM-SUNOS.cv311.P1-1.tar file,

TM-HPUX9.cv311.P1-1.tar file, TM-HPUX10.cv311.P1-1.tar file,

TM-AIX.cv311.P1-1.tar file and TM-NT95.cv311.P1-1.zip (WindowsNT
3.51 and

Windows95) file includes the electronic network management package file

(Threshold_<OS>.pkg).

The tar file also includes a copy of this README file in ASCII format, and

a copy of the Threshold Manager Getting Started Guide in pdf format.

DEVICES SUPPORTED

Threshold Manager supports Cisco IOS Releases 11.1 and 11.2 devices

that support RMON events and alarms.  It also supports the Cat1200 and

Cat5000 switches.  The Cat5000 switches support the Ethernet

statistics group only.  The 1200 series supports the setting of Ethernet

statistics and all other MIB variables.
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If the switching device packages have not been updated on the supported

Catalyst devices, you need to make the following changes in order to use

Threshold Manager:

Add the line:

  source $Cv_Path/devices/All-share/CRMON.dd

to the end of each of the following files:

  $Cv_Path/devices/Cat5000/C5000.dd

  $Cv_Path/devices/Cat1200/C1200.dd

  $Cv_Path/devices/Cat1200/C1200V4.dd

For Cisco7000 routers:

If the new 7000 package has not been updated and If you are unable to

see the Tools pulldown menu containing the Threshold Manager item,

the following two changes are needed in the c7com.dd file

(located in NMSROOT/etc/cview/devices/7000/dd/c7com.dd):

1)  Change:

    source $Cv_Path/devices/Router-share/CRTOOLBR.dd

    source $Cv_Path/devices/Router-share/C47CH.dd

    To:

    source $Cv_Path/devices/Router-share/C47CH.dd

    source $Cv_Path/devices/Router-share/CRTOOLBR.dd

2)  Change:

    set DD(menubar.menu)  {{{} "Admin" admin}}

    To:

    lappend DD(menubar.menu) {{} "Admin" admin}

The various performance and fault indicators of Cisco devices can be
monitored

by using the Threshold Manager application. This application takes
advantage of
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the RMON alarm and event groups implemented in the agent to set
thresholds.

Since there are different levels of RMON support in terms of what variables
may

be set among the agent implementations, a user of a generic RMON
application

might have to try multiple times for each setting. Threshold Manager

application simplifies the user's task by learning of the agent capability and

limiting the setting to just these supported variables. In addition, for quick

setting of thresholds, Threshold Manager comes with a set of predefined

threshold policies that can be used as is or modified to suit a particular site.

Support for setting thresholds in Cisco devices varies in terms of which

variables can be set. First of all, thresholds can only be set on INTEGER,

Counter, Gauge, and Timeticks MIB variables. Some Cisco devices limit
further

the set of MIB variables that can be used to set thresholds. Note that some

devices require the RMON feature to be enabled before you can set
thresholds.

For example, IOS-based devices might have the RMON feature enabled or
disabled.

Catalyst switches enable or disable the RMON function depending on the
value

of the sysEnableRmon MIB object (in the CISCO-STACK-MIB).

IOS-Based Devices:

-----------------

All routers starting with the IOS version 11.1 have RMON threshold
capability.

There are 2 implementations of RMON in the IOS-based agents. Both
versions

support the setting of all MIB variables the agent supports (subject to the
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above restriction on the MIB variable type). This includes, for example,
MIB-II

variables and Cisco enterprise MIB variables.

The so-called RMON-lite implementation supports all the MIBs that the
agent

supports. The full RMON implementation (with an 'm' in the image name)
extends

over all RMON groups. For  Threshold Manager users, this means the setting
of

the Ethernet statistics group is also supported.

Threshold Manager Support for Default Thresholds

---------------------------------------------

To ease the setting of threshold variables, the Threshold Manager comes with

a set of predefined threshold policies. The predefined policies cover a wide

range of MIB variables that might prove useful for setting thresholds. These

variables are organized in several groups:

(1) System. These are system group variables that are part of the Cisco
System

    MIB. Examples are the CPU busy percentage and the available memory
size.

(2) Interfaces. MIB-II interfaces and Cisco local interface variables are

    predefined. Examples of this group are ifInOctets and locIfResets.

(3) Ethernet Statistics variable. Interesting MIB variables from this group,

    such as etherStatsPkts and etherStatsCollisions, are included in the

    predefined threshold policies.

In total, there are 18 predefined threshold policies.  Support for these

predefined MIB variables also includes the run-time (at program startup

time) filtering of MIB variables that are not supported by a particular device.
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Threshold Manager presents the user with relevant MIB variables for
selection.

Note that many of these are interface-related MIB variables and so can be

applied to multiple MIB instances. This can be done automatically by
Threshold

Manager.  Pre-defined MIB variables may be changed and saved to disk for
future

reference. The user has the option to save an altered policy to be used by all

devices, by all devices of the same class, or just for the current device.

Support for Customized Thresholds

---------------------------------

With the predefined set of threshold policies, a wide range of MIB variables

useful for monitoring is available for immediate use to the user. The user

can always modify the threshold values for these variables.

Beyond the predefined set of threshold policies, Threshold Manager provides

limited support for creating customized threshold policies or settings.  This

task starts with the classification of a threshold variable. The classification

allows the user, for example, to specify the threshold to be applied to all

interfaces or even a particular subset based on the interface speed. Another

example is that the user can specify a threshold in terms of percentage of

bandwidth and Threshold Manager will automatically calculate the actual

threshold value when it creates the RMON entries. The interface could be
MIB-II

interface or Cisco interface extension.  This subdivision allows Threshold

Manager to present just the applicable MIB variables for a particular device.

Depending on the selection of the classification (target type), Threshold

Manager will enable or disable the appropriate input fields.

For specific MIB variables that are not part of an interface table (MIB-II or
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Cisco specific), the user can fully qualify the threshold variable including

the instance Object ID. This customization feature practically allows for

the creation of any threshold. One limitation is that this kind of

customization cannot be saved to disk. Also note that, per RFC 1573, not all

objects in the interface MIB apply to all interface types. Make sure that a

given MIB object is applicable for that interface type by directly retrieving

it before you attempt to apply thresholds to it.

Note: the deletion of threshold polices is not supported by

Threshold Manager.  This limitation includes both the predefined and

customized threshold policies. The user needs to go the disk directory of the

threshold configuration to delete unwanted threshold policies.

OTHER DEVICES

--------------

For RMON-supported devices that are not supported by CiscoView,
Threshold

Manager must be started from the command line or by selecting File->New

from the Threshold Manager main menu.  See Chapter 1 of the Threshold

Manager Getting Started Guide for more details.

CURRENT DOCUMENTATION

Look for the Threshold Manager Getting Started Guide on the Cisco
Connection

Documentation, Enterprise Series CD-ROM.  This manual is also included in

the tar and ZIP files in PDF format.

NOTES

*  When you start Threshold Manager using the wrong write community
string,

   the application runs as  read-only.  All profiles are loaded at start time,

   but they cannot be enforced.
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*  If a new default policy is enforced by one instance of Threshold Manager

   and another instance is viewing events, the second instance will not be

   able to view all information for the policy until user executes Retrieve

   Threshold in the Config Thresholds dialog.

CAVEATS

This section contains caveats about problems you might encounter while
using

Threshold Manager.

Some agents, most notably the Catalyst switches, impose a limit on the
number

of alarm and event entries that can be created. Applying a large number of

thresholds to these devices will likely fail. In this case, some alarm entries

might be successfully created but their associated event entries are not.

These failed creations are marked as "Failed" in the Current Threshold

Settings pane. If you attempt to delete those settings, Threshold Manager

reports that the deletion failed (because it cannot delete nonexistent

event entries.) In this case, you can ignore the error message, and can

verify that the deletion occurred by retrieving the threshold settings after

the deletion.

#1.

ID #: CSCdi61080

  Description:

  Cisco7000 devices do not display Threshold Manager in the CiscoView

  pulldown menu.

  Workaround:

 See the Supported Devices section above for information on how to

  modify the c7com.dd file or update the 7000 package.

#2.
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ID #: CSCdi62741

  Description:

  New policies are always added to the display list.

  Workaround:

  Exit from the Configure Thresholds window, then reopen it.

#3.

ID #: CSCdi62739

  Description:

  Policy file names won't match if IP address is used.

  Workaround:

 Use hostname instead of IP address when saving host-specific policies.

#4.

ID #: CSCdi68329

  Description:

  Duplicate global/device/host policies may be allowed, depending on which

  window is used.

  Workaround:

  When creating a custom policy, you can only save it once, either as global,

  device or host.  But after saving the policy, you can use the Modify

  Threshold Policy window to modify the saved custom policy and save it

  as all three.

#5.

ID #: CSCdi69251

  Description:

  On Solaris, the Source field in the Config Threshold Policy window shows

  HOST for profiles saved as host-specific, but NT displays the actual name

  of the device.
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  Workaround:

  None.


